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Sissejuhatus 

Taavi Kontserniprogramm on mõeldud kontserni finantsaruannete koostamise 

lihtsustamiseks. 

Programm võimaldab koostada taandatud bilansi ja kasumiaruande, kui ka tuua eraldi 

välja kontsernisiseselt taandatavad summad. Kontserniprogramm võtab andmed Taavi 

raamatupidamisprogrammist , milles peetakse arvestust iga tütarfirma kohta eraldi 

(käibeandmikuna ). 

Aruanded koostatakse põhimõttel – kogu tütarfirma käibest lahutatakse käibed 

teistesse tütarfirmadesse , mille tulemuseks on taandatud summa . 

Kontserni programmis võib olla kasutusel tütarfirmadest erinev kontoplaan , kuid 

tingimuseks on , et kontsernikontoplaan sisaldab tütarfirmade kontoplaane. 

Taavi programmi puhul ei ole vajalik iga kontserni tütarfirma jaoks kirjeldada eraldi 

kontosid . Kande tegemisel eristab tütarfirmasid tavaline kliendi number. Eraldi andmetabelis 

kirjeldatakse tütarfirmade struktuur ning pannakse vastavusse kliendi numbriga. 

 Kontserniprogrammi võib kasutada ka mitmelt töökohalt korraga, s.t. 

võrguversioonina. 

Aruandeid on võimalik lihtsalt eksportida nii Excelisse kui Word’ i. 

    

 

Programmi töö üldpõhimõtted 

Kontserni programm kasutab oma tööks tegelikke raamatupidamisandmeid. 

Taavi raamatupidamisprogrammis kirjeldatakse eraldi menüüs kontserni firmad, määratakse 

neile numbrid ning seotakse nad tavalise reskontro kliendiga. Mis tähendab, et kui üks tütarfirma esitab 

teisele arve, siis tehakse selle kohta tavaline kanne, millel märgitakse klient, s.t. tütarfirmade 

omavahelised tehingud sisestatakse raamatupidamisprogrammis nagu kõik teised tehingud, kuid oluline 

on  kliendi number kandele märkida. Kliendi numbri järgi (mis on seotud tütarfirmade loeteluga ) 

koostab raamatupidamisprogramm käibeandmiku, s.t. iga tütarfirma kohta tekib oma käibeandmik, mis 

sisuliselt ongi kontserni sisemine liikumine. Ühes raamatupidamise süsteemis on mitu tütarfirma 

käibeandmikku, sõltuvalt sellest, mitme teise tütarfirmaga arveldatakse. Need erinevate süsteemide 

tütarfirmade käibeandmikud ongi kontserniprogrammi aluseks.  

 

 Kontserniprogrammis kirjeldatakse niipalju erinevaid tütarfirmasid, kui palju on kasutusel 

erinevaid raamatupidamiseprogramme e. eraldi juriidilisi tütarfirmasid. 

 Kontserniprogramm oma ümberarvutuse ajal võtab andmed raamatupidamisprogrammi 

tütarfirmade andmikest, tekitab iga tütarfirma kohta omakorda käibeandmiku, milles on kuude ja teiste 

tütarde kaupa toodud käibed, näiteks selliselt: 

 

kokku firma  1     1000.-  

käive firmasse 2     100.- 

käive firmasse 3      150.- 
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mis tähendabki, et kontserni taandatud käive on 1000.- miinus 250.- e. 750.- 

e. aruannetesse satuvad summad järgmistele ridadele: 

 

raamatupidamislik summa 1000.- 

sisekäive 250.- 

puhaskäive 750.- 

 

Firmade käibeandmikesse toodud summasid saab vaadata ja kontrollida, muuta andmeid ei saa, kuna 

järgmise ümberarvestuse ajal võetaks taas algandmed tegelikust raamatupidamisest. 

Käibeandmike alusel koostatakse kontserni taandatud bilanss ja kasumiaruanne, kus tuuakse välja 

raamatupidamislik summa, sisekäive ning taandatud summa.  

Lisaaruannetesse tuuakse summad kontode tasemel, et oleks võimalik teostada kontrolli ja lihtsamalt 

vigu leida. 

  

Raamatupidamiskannete tegemisel (kontoplaani ja süsteemi väljatöötamisel ) on oluline 

jälgida, et kogu kontserni ulatuses ühes perioodis (pikim periood saab olla aasta ) kasutatav 

aktiva konto, mida taandatakse , saaks vastavusse samas perioodi passiva konto , mida 

taandatakse. Vastasel korral ei lähe omavahel võrduma kontsernisisene aktiva ja passiva 

ning seetõttu ka taandatud aktiva ja passiva. 

 

Programmi käivitamine 

 Programm käivitub käsuga kontsern.exe, mille tulemusena avaneb tarkvara TAAVI 

käivitusekraan. 

Kuupäevaks pakub programm arvuti kuupäeva, kui see pole õige, tuleks kuupäev parandada - 

liikuda kuupäeva väljale ja trükkida õige kuupäev. Hiire klõps kasutajanime väljal viib Teid 

kasutajanime tühjale väljale, kuhu tuleks trükkida kasutaja nimi. Esmakordsel programmi kasutamisel 

on kasutaja nimeks TAAVI. Pärast kasutaja nime trükkimist tuleb teha hiireklõps võtmesõna väljal 

ning trükkida sinna võtmesõna. Esmakordsel programmi käivitamisel on selleks  kuus X -tähte. 

Ekraanile tuuakse tärnid, et keegi teine juhuslikult ei näeks võtmesõna. Programmis on võimalik igale 

kasutajale eraldi defineerida nii kasutajanimi kui tema salasõna. Kuid esmakordsel käivitamisel on 

nendeks vastavalt TAAVI ja kuus x-tähte. 

P.S. Pärast esmakordset programmi sisenemist oleks mõistlik lisada kasutajate nimekirja 

korrektne kasutaja nimi ja tema võtmesõna, siis proovida selle kasutaja nimega programmi siseneda 

ning  kui kõik on korras, kustutada kasutaja Taavi kasutajate nimekirjast ära (vt . Seadistused -> 

Kasutajad , programmis File -> Seadistused -> Kasutajad )  

Pärast võtmesõna trükkimist, tuleb vajutada klahvile ENTER või teha hiireklõps nupukesel 

‘Alustame tööd’, et programm saaks käivituda.  

Ekraanile tuuakse programmi peamenüü. 

Ülemises ekraani servas on menüüde pealkirjad, millest igaühest avaneb alammenüü.  

Menüüdel saab liikuda , kui teete hiireklõpsu sobival menüül. Aktiivse peamenüü või alammenüü taust 

on tume (…sinine).  

Hiireklõps sobival peamenüül avab alammenüü. 
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Menüüdel liikumiseks võib kasutada hiirt (või noole klahve) ning liigutada teda menüül üles - alla. 

Peamenüül olles võib hiirt liigutada vasakule-paremale, mille tulemusena avatakse ekraanil järgmine 

alammenüü. Menüü käivitamiseks tuleb hiire nooleke viia soovitud menüü reale ja teha üks hiire klõps 

, mille tulemusena avatakse vastav andmetabel või käivitub dialoog või alustatakse mingit tegevust.  

 

Registreerimine 

Kontserni programmis litsentsi registreerimiseks tuleb täita registreerimiskaart, mis on 

koos installeerimisketaste ja juhendiga. Täitke palun kaart ja faksige TAAVI TARKVARA 

OÜ faksile , mis on kaardil kirjas. Kui Teil on E-mail’ i aadress, siis kirjutage see kindlasti 

registreerimiskaardile. Helistage TAAVI Tarkvarasse või müüjale ning Teile öeldakse Teie : 

*  TOOTE KOOD 

*  REGISTREERIMISKOOD  

Registreerimist on vaja programmis teostada seetõttu, et installeerimisketastel on 

programm registreeritud Taavi Tarkvara Demo’na, mis tähendab, et programmi kasutamine on 

piiratud. 

Registreerimiseks käivitage menüü FILE -> Seadistused - Registreerimine. Ekraanile 

tuuakse registreerimisekraan., mis tuleb täita järgnevalt: 

Litsentsi omanik - firma nimi, mille Te kirjutasite registreerimiskaardile. Sisestage palun 

täpselt sama moodi nagu kaardile märkisite - suured-väikesed tähed, tühikud on olulised. 

Toote kood - sisestage toote kood, mis Teile teatati, tavaliselt WPE1AAMMDD , kus AA-aasta , MM -

kuu , DD- päev 

Registreerimiskood - sisestage Teile teatatud registreerimiskood . 

NB! Registreerimiskoodis pole tühikuid ega nulle . Nullide asemel on O-tähed !!!  

Kui kõik lahtrid on korrektselt täidetud, tehke nupukesel Registreeri hiireklõps. Kui 

kõik läks õigesti , teatab programm : Kontserni programm edukalt registreeritud. Juhul, kui 

kõik ei läinud edukalt, teatab programm: Registri kontrollsumma vale ning programm läheb 

demo- režiimi. 

Kontrollige toote ja registreerimiskoodi , äkki läks midagi valesti ja proovige uuesti. 

Võite programmi kinni panna ja uuesti käivitada.  

Kui ka teisel ega kolmandal korral registreerimine ei õnnestu, võtke ühendust 

müüjaga. 

 

 

Peamenüüde kirjeldus 

Menüüd on programmis üles ehitatud põhimõttel - vasakult paremale - andmete 

sisestuselt aruanneteni. Kaks kõige vasakpoolsemat menüüd on tavalised windows  

programmi menüüd File ja Edit, milledes on võimalik seadistada programmi, muuta  

kirjakuju ja  milledes asuvad vähemkasutatavad registrid, nagu printerid või kasutajate  

defineerimine. Pärast Edit menüüd tulevad järgmistena  : 
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 registrid ,  

 firmade käibed , 

 aruanded  

ning nende järel vähemkasutatavad menüüd: 

 aken 

 abi.  

 

Toome siinkohal peamenüüde sisulise kirjelduse: 

File – tööperioodi valimine, seadistused , andmete hooldus, kasutajate sisestamine.   

Seadistused : 

 kasutajad - palgaprogrammi kasutajate registreerimine 

 kirjakuju - tabelite, sisestustekstide ja püsitekstide kirjakuju (inglise keeles font) muutmine 

 printerid - tööks kasutatava printeri kirjeldamine (tavaliselt pole vaja midagi kirjeldada ) 

 värvid - programmi värvide muutmine 

Andmete hooldus : 

 andmebaasi koopia 

 uute indeksfailide koostamine 

 andmebaaside korrastus ja kontroll ( e. andmestruktuuride kontroll)  

 koopia taastamine  

Lõpeta: töö lõpetamine programmiga 

Edit -  taasta, kopeeri , lõika , esimene, järgmine , eelmine , viimane kaart 

Registrid - programmi tööks vajalikud registrid  e. teatmikud - 

 firmad  

 kontod 

 kontogrupid  

 

Firmade käibed  - firmade andmike ümberarvutus, firmade andmike vaatamine firmade kaupa 

Aruanded – kontserni taandatud bilanss ja kasumiaruanne ning lisaaruanded, mis abistavad andmete 

kontrollimisel  

 

Aknad - töö akendega - aknad kinni, aknad kaskaadi jne. 

Abi - abitekst ja info programmi kohta - 
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*  programmi versiooni number ja kuupäev; 

*  info programmi autori kohta; 

*  info litsentsi omaniku kohta. 

 

Töö andmetabelitega 

 Andmete sisestamine programmi toimub alati kindlate ühesuguste reeglite 

alusel. Programmis tuuakse kõik andmed ekraanile tabeli kujul, mida edaspidi 

nimetame andmetabeliteks. Näiteks kontoplaanis on toodud kõik kontod tabeli kujul. 

Tabeli kujul on andmeid ekraanil võimalikult palju ning nad on ülevaatlikud. 

Andmetabelisse andmeid sisestada (andmeid muuta või lisada) pole võimalik.  

Andmete sisestamine toimub programmis läbi ekraanide, mille käivitab hiire klõps 

Vaata nupukesel (programmis illustreeritud silma kujutisega, samuti võib kasutada enter klahvi ). 

Andmetabelit võib kasutada mingi kindla rea otsimiseks ja vaatamiseks. 

Andmetabelites on võimalik otsida andmeid tabeli veergude järgi. Näiteks asute Te veeru konto 

kõige esimesel real. Selles veerus saate otsingut teostada konto numbri järgi. Kui vajutate mingit 

numbrit , näiteks ‘ 1’, avaneb otsingu väli ‘Leia…’, kuhu saate 

trükkida otsitava konto numbri ning pärast hiireklõpsu  jääb programm otsitud 

konto numbri reale. 

 

NB! Kõiki andmetabeleid  saab sorteerida veergude järgi, millede veeru 

pealkiri on SINISE KIRJAGA !!!  

 

Otsida asukoha reast allapoole saab kõikides veergudes. 

 

Andmetabelis on võimalik kasutada nn. kiirklahve liikumiseks andmetabeli esimesele 

või viimasele reale, need on tähistatud nupukeste real nooltega - ‘Esimene’, ‘Eelmine’, 

‘Järgmine ’, ‘Viimane’. 

 

Andmete sisestamine toimub nn. ekraanidesse, mitte andmetabelitesse.  

 

Andmete sisestamisel kasutatakse programmis nn. nupukesi, mis asuvad 

nupukeste ribal. 
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Näiteks nupuke, millel on kiri  lisa , lisab andmerea , kui teha nupukesel hiireklõps. Enne 

nupukestel - Vaata, Kustuta, Valik, Uus  - hiireklõpsu tegemist, tuleb avada mõni andmetabel,  

kuna vastasel korral ei tea programm, millisesse andmetabelisse tuleb rida lisada . 

Avatud andmetabelis (andmetabel on ekraanil ) saab kasutada järgmisi nupukesi:  

 

Lisamine - lisab  uue andmerea , näiteks töötaja, tasu, jne. 

Vaata - saab parandada rida, millel andmetabelis asuti. 

Kustuta - kustutab tabelist rea (vt. kustutamise protseduur), millel asuti. 

Ekraani väljadel saab liikuda kas TAB klahvi kasutades või tehes hiire klõps sobival 

väljal (võib kasutada ka nool-alla klahvi). SHIFT-TAB klahv viib eelmisele väljale.  

Valik - avab registri, millest saab andmeid valida. Kui asutakse numbri väljal, avab 

Valik kalkulaatori, kui asutakse kuupäeva väljal, avatakse kalender.    

 

Andmetabelite kirjeldust e. tabelisse toodud veerge on võimalik muuta. Näiteks soovite Te 

töötajate tabelisse lisada veergu sünnipäev. Selleks tuleb Teil teha parem hiireklõps tabeli 

pealkirja real. Ekraanile avaneb aken menüüga: 

 Lisa veerg 

 Kustuta veerg 

 Veeru pealkiri 

 Veeru joondamine 

 Salvesta veerud 

 

Tabelisse veeru lisamiseks tuleb valida ‘Lisa veerg’, ning ekraanile toodavast andmeväljade 

loetelust valida sobiv väli tehes sellel hiirklõpsu. Enne välja tabelisse lisamist võib muuta ka 

veeru pealkirja trükkides Pealkirja lahtrisse soovitud veeru pealkirja. Ok nupukesel hiireklõps 

lisab soovitud veeru andmetabelisse. Selleks, et ka järgmisel korral avaneks Teie poolt 

kirjeldatud andmetabel, tuleb tabeli kirjeldus salvestada. Selleks tuleb teha parem hiireklõps 

tabeli pealkirja ribal ning menüüst valida ‘Salvesta veerud’.  

 

‘Kustuta veerg’ kustutab tabelist veeru, mis on aktiivne. 

‘Veeru pealkiri’ - võimalus muuta ainult veeru pealkirja, mis on aktiivne. 
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‘Veeru joondamine’ -  joondab veeru pealkirja kas vasakusse või paremasse serva või keskele. 

 

‘Taasta algseis’ - kustutab kõik Teie poolt sisestatud ja salvestatud tabeli kirjeldused ning 

paneb programmi algseisus olnud tabeli kirjelduse sellele andmetabelile, milles olete , mitte 

kõikidele. 

Andmetabelite veerge on võimalik ka tõsta teise kohta, selleks tuleb veeru pealkirjal olles teha 

vajutada vasakut hiireklahvi ja seda all hoides lohistada veerg sobivasse kohta. Kindlasti tuleb 

pärast veeru kirjeldus ka salvestada.   

 

Klaviatuuri kasutamine 

Lisaks hiire kasutamisele võib programmi kasutada ka ainult klaviatuuri abil. Siis on klahvidel 

järgmised tähendused : 

F3 – lisa 

F2 – muuda 

Esc – väljumine (ekraanilt, tabelist) 

Enter – käivita  ( rea , menüü vaatamine, avab registri ) . Näiteks konto kaardil lahtris grupp  

avab gruppide nimekirja, millest grupi valimiseks tuleb liikuda sobiva grupi reale ja vajutada 

enter.  

Tab – järgmisele väljale 

Shift - Tab – eelmisele väljale 

Nool – alla – järgmisele väljale 

Nool üles – eelmisele väljale 

Tühik – märgib lahtrisse linnukese 

Alt – avab menüü  

 

Üldkasutatavad funktsionaalsed nupud 

 Programmiga töötamisel kasutatakse ühesuguste tegevuste sooritamiseks alati samu nupukesi 

või klahve / klahvikombinatsioone. Tegevuste nupukesed on toodud andmetabelite ülaservas 

nupukeste ribal - nupukesel on ka kiri, mida selle nupukesega teha saab .  

 Programmis TAAVI kasutatakse järgmisi nupukesi ja klahve : 

 

Lisa Lisamise nupuke , F3 lisab andmerea tabelisse, mis on avatud  

Vaata Muutmise nupuke , F2 avab ekraani vaatamiseks ja muutmiseks 

Salvestamine, tagasi, välja Sulgemise nupuke ,Esc sulgeb ekraani, tabeli - ristike paremal ülaservas  
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Valik Avab registri , Enter registrist andmete valimiseks väljale 

avab kalkulaatori numbri väljal 

avab kalendri kuupäeva väljal 

edasi-tagasi liikumiseks 

menüüdel ja väljadel 

Hiireklõps väljal 

TAB 

SHIFT-TAB  

Nool-alla 

Nool-üles 

nii menüüdel kui ekraani väljadel 

järgmisele väljale 

eelmisele väljale 

järgmisele väljale 

eelmisele väljale 

Kustuta Kustutamise nupuke kustutab andmerea, millel  asutakse  

Enne kustutamist küsib programm - ‘Kas olete 

kindel, et soovite andmerida kustutada- vastates 

JAH kustutatakse rida, millel asutakse, EI 

katkestab kustutamise.  

Andmetabelist aruanne Printeri  nupuke trükib aruande andmetabelist, mis avatud on 

Kalender  Kalender avaneb, kui olete kuupäeva väljal ja 

teete Valik nupukesel hiire klõpsu. Sobival 

kuupäeval olles tehke OK nupukesel hiireklõps. 

Kuupäeva väli täidetakse kalendrist valitud 

kuupäevaga. 

 

Kalkulaator numbri lahtris  Kalkulaator avaneb, kui numbri väljal olles 

teete Valik  nupukesel hiire klõpsu. Edit->Copy 

salvestab soovitud numbri  ning CTRL->V 

(Paste) toob ta programmi väljale. 

Firmad  Avab firmade nimekirja Kiirvaliku nukuke, mis annab võimaluse 

vaadata firmade nimekirja ,ilma firmade  

registrit enne avamata 

Kalkulaatori märk   Käivitab firmade andmike 

ümberarvestuse   

Nupuke käivitab firmade andmike 

ümberarvestuse.   

 

NB! Alati on ekraani kõige ülemisel real toodud nupud, mida antud hetkel on 

võimalik kasutada !  

 

Nupukesed on dubleeritud ka hiire parema klahviga. Olles andmereal ja vajutades paremat hiireklahvi, 

on võimalik kasutada järgmisi tegevusi: 

muuda 

lisa 

kustuta 
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tabel kinni  

 

Olles ekraanil mõnel väljal ja vajutades hiire paremat klahvi, on võimalikud järgmised tegevused: 

Cut  

Copy 

Paste 

Delete 

Select all 

Vali - avab registri, millest saab väljale sobiva väärtuse valida 

 

Kustutamise ja muutmise  

Programmis võib andmeid kustutada ja muuta alati kasutaja, kes on 

nad sisestanud. 

Andmetabeli rea e. ühe konto jne. kustutamiseks tuleb andmetabelis liikuda 

hiirega sobivale reale ja  klõpsutada kustutamise nupukesel (või teha parem 

hiireklõps ja valida menüüst ‘kustuta rida’). Programm alustab terve rea 

kustutamisega. Ekraanile tuleb küsimus: 

  

Kas soovite kindlasti seda rida kustutada ?  

Enne kustutamist programm hoiatab, et JAH valik kustub terve andmerea. 

Enne 

JAH valimist tasub alati kontrollida, kas Te olete ikka sellel real, mida 

kustutada 

soovite. Rida, millel asute on teistsuguse värviga, kui ülejäänud. Jah 

valimiseks 

tuleb teha hiireklõps JAH peal . Andmerida kaob andmetabelist. Kui Te ei 

soovi 

andmerida kustutada, siis tehke hiireklõps vastusevariandi EI peal. 

 

Andmete parandamiseks tuleb andmetabelis olles liikuda parandada soovitud 

reale (konto jne.) ja teha ‘Vaata’ nupukesel hiire klõps või topelt hiireklõps 

andmereal. 

Programm avab andmete ekraani, millel võib andmeid parandada juhul, kui 

see on lubatud ( ettenähtud ) .  

 

TAB (SHIFT-TAB) või hiirega tuleb liikuda väljale, mida soovitakse 

parandada 
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ning trükkida sinna uus väärtus ja liikuda järgmisel väljale. Tagasi eelmisele 

väljale saab SHIFT-TAB klahve kasutades (või hiireklõps sobival väljal).   

 

 

Trükiprotseduuri kirjeldus 

Aruannete ja teatmike trükkimine programmis koosneb kahest osast: 

1. aruanne koostatakse ja tuuakse ekraanile 

2. ekraanil olev aruanne saadetakse printerisse. 

Enne aruande printerisse saatmist tuuakse ta alati ekraanile, et oleks 

võimalik ta üle vaadata ja kontrollida . Aruandeid on võimalik lihtsalt 

eksportida erinevatesse formaatidesse, näiteks tabel , Word tekstiredaktorisse, 

tavaline tekstifail jne. Enne aruande koostamist küsitakse, kas aruannet 

soovitakse ekraanile, printerile või eksportida.   

Kui ekraanil olev aruanne sobib printerisse saatmiseks, siis pange 

printer töökorda ja klõpsutage printeri ikoonil. Programm trükib aruanded 

printerisse, mis on Windows all häälestatud .  

Enne aruande koostamist küsitakse ekraanil, mitu koopiat ja milliseid 

lehti soovitakse trükkida. Sisestage koopiate arv, kui soovite rohkem kui 1 

koopiat. 

Kõikidest programmis olevatest andmetabelitest (teatmikest) saab väljatrüki, kui teete 

andmetabelis olles printeri ikoonil hiireklõpsu.  

 

 

Aruannete selekteerimine 

Programmi juurde kuulub hulk erinevaid  aruandeid , mida saab käivitada menüüst Aruanded -

> ‘Muud aruanded ‘ või ‘Lisaaruanded’. Aruannete hulgast on võimalik välja valida need, mis 

sobivad tööks kõige enam. Kõik aruanded on esialgu tähistatud rohelise ringikesega, mis 

tähendab, et nad kõik on lubatud. Kõikide aruannete ekraanile toomiseks tuleks teha täpike 

lahtrisse ‘Kõik’. 

Aruande keelamiseks tuleb liikuda aruande nimetuse peale nii, et ta muutub tumesiniseks ning 

teha parem – hiireklõps . Ekraanile tekib menüü, millest tuleb valida ‘Keela’ , mille 

tulemusena kaob aruanne ‘Minu omad’ nimekirjast ära. Kui teha täpike lahtrisse ‘Kõik’ tekib 

nn. ‘keelatud aruanne’ nimekirja punase ringikesega. Aruande lubamiseks tuleb jällegi liikuda 

aruande nime reale ning teha parem – hiireklõps ja valida ‘Luba aruanne’, mille tulemusena 

ilmub aruande ette roheline täpikene.  

Menüü ‘Trüki’ võimaldab koostada aruannete nimekirja ning selle ka printerile väljastada. 

Menüü ‘Kopeeri eelistused’ võimaldab ühe kasutaja poolt välja valitud aruandeid kopeerida 

teistele kasutajatele. Selleks tuleb programmi siseneda teise kasutaja nime ja võtmesõnaga . 

Parem hiireklõps toob ekraanile küsimuse :’Kopeerime jooksvad eelistused kasutajalt ‘ 

.Lahtrisse tuleb sisestada kasutaja nimi, kelle aruannete eelistusi soovitakse jooksvale 

kasutajale kopeerida. Hiireklõps OK nupukesel toob ekraanile küsimuse, :’Kas kopeerime 

kasutajanimele [kasutaja kaks e. jooksev kasuta ] kasutaja [kasutaja üks ] aruandeelistused ?’ . 

Hiireklõps OK nupukesel kopeerib aruandeeelistused. Kui märkida lahtrisse ‘Kõik’ täpike, siis 

on punase ringiga märgitud samad aruanded, mis on punase ringiga märgitud kasutaja üks 

poolt.  
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Aruannete tingimuste muutmine 

Aruannete käivitamistingimusi on võimalik kasutajal ise muuta. Selleks tuleb viia kursor 

aruande nimele nii, et aruande nimi muutub tumesiniseks ning teha linnuke lahtrisse 

‘Muudame aruande tingimusi’ . Hiireklõps ‘Trüki’ nupukesel käivitab aruande. Pärast 

aruande parameetrite sisestamisest tuleb ekraanile lisatabel, kus on kirjas aruande käivitamise 

tingimused. Näiteks võib olla aruanne piiratud kuude vahemiku vm. tunnuse järgi. 

Tingimust saab muuta kui liikuda muuta soovitud rea peale ning teha ‘Edit’ nupukesel 

hiireklõps. Tingimuse muutmise ekraanil on järgmised lahtrid: 

And/or  - jah / või 

Field   - andmebaasi väli või aruande jaoks spetsiaalne väli 

Comparision - suurem/väiksem/võrdne/väiksem võrdne/suurem võrdne jne. 

Compared to - võrreldav millega ? e. andmebaasi väli vm. aruande jaoks loodud väli 

Hiireklõps OK nupukesel salvestab tingimuse tingimuste tabelisse. 

Tingimusridu  saab lisada , kui valida ‘Append’ valik. Vahele saab ridu panna  

‘Insert’ nupukest kasutades ning kustutada saab ‘Delete’ nupukest kasutades.  

 

Programmi töösse rakendamine 

Registrite koostamine 

Firmad 

Firmade registris kirjeldatakse firmade raamatupidamisprogrammide asukohad, kusjuures 

väga oluline on firma järjekorranumber, mis peab olema sama , mida kasutatakse 

raamatupidamisprogrammis. Näiteks: 

Firma AAA raamatupidamises on kontsernimoodulis kirjeldatud 2 tütarfirmat: 

tütarfirma jääb kirjeldamata , kuna firma AAA ongi esimene tütarfirma  

tütarfirma on firma BBB  

tütarfirma on firma CCC 

Firma BBB raamatupidamises on kontsernimoodulis kirjeldatud 2 tütarfirmat : 

tütarfirma AAA  

jääb kirjeldamata, kuna BBB ongi teine tütarfirma 

tütarfirma CCC 

Firma CCC raamatupidamises on kontsernimoodulis kirjeldatud kaks tütarfirmat: 

tütarfirma AAA 

tütarfirma BBB 
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jääb kirjeldamata, kuna CCC on ise kolmas tütarfirma 

 

Kontserniprogrammi menüüsse Registrid -> Firmad tuleb tütarfirmad kirjeldada järgmiselt: 

Nr. 1 tütarfirma on firma AAA – kataloogiks tuleb märkida firma AAA raamatupidamise 

asukoht arvutisüsteemis  

Nr. 2 tütarfirma on firma BBB - kataloogiks tuleb märkida firma BBB raamatupidamise 

asukoht arvutisüsteemis  

Nr. 3 tütarfirma on CCC - kataloogiks tuleb märkida firma CCC raamatupidamise asukoht 

arvutisüsteemis  

 

Uue rea lisamiseks tuleb nupukesel ‘uus’ teha hiireklõps (suur roheline pluss märk 

ikooniribal) ning tühjad väljad tuleb täita järgmiselt: 

Number – tütarfirma järjekorranumber süsteemis , meie näites firma AAA on nr. 1, firma  

BBB on number 2 ja firma CCC on number 3 

Lühend – tütarfirma lühikood , 10 sümbolit, märgitakse aruannetesse 

Firma nimi  – tütarfirma nimetus 

Kataloog – firma raamatupidamise asukoht (drive, kataloog ) arvutisüsteemis  

Osalus – kontserni osalus firmas 

 

Kui kõik tütarfirmad on tabelisse kirjeldatud, siis võib korraks programmi kinni panna . Uuesti 

käivitamisel kontrollib programm, kas tütarfirmade kataloogid on kättesaadavad ning ,kui 

pole, annab ekraanile vastavasisulise teate, mille järel peaks kontrollima, kas asukoha 

sisestamisel pole eksitud. 

 

Kontod 

Kontserni programmis on väga tähtsal kohal konkreetse konto kaart, kuna sellele märgitakse 

tunnused, mille järgi toimub aruannete (ka ümberarvestus ) koostamine. Kontoplaan 

kontserniprogrammis võib olla erinev kontoplaanist konkreetsetes tütarfirmades, kuid ta peab 

kindlasti sisaldama tütarfirmades kasutusel olevaid kontosid. 

Kontsernikontoplaani saab koostada menüüst Registrid - > Kontod . 

Uue konto lisamiseks tuleb teha ikoonil ‘Uus’ hiireklõps ning tühjad väljad täita järgmiselt: 

Konto - konto number , kuni 10 sümbolit 

Tüüp – täitub, kui valite kontogrupi , tüüp võetakse grupi kaardilt  

Grupp – kontogrupp, tehke paremhiirklõps ja siis ‘vali’ ning valige sobiv kontogrupp .  

Selleks, et konto kaardile kontogruppe saaks valida, tuleb nad enne registrisse lisada (v. t. 

kontogrupid ) 

Nimetus – konto nimetus 
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Võõrkeeles – konto nimetus võõrkeeles 

Sisekäibed kontsernis taandatakse – linnuke lahtris tähistab, et sellele kontole tehtud käibed 

lahutatakse üldsummast maha. Tavaliselt on sellisteks kontodeks reskontro kontod ostjate 

tasumata arved ja hankijatele tasumata arved 

Sisestatakse käsitsi ei summeerita – linnuke lahtris tähistab, et seda kontot ei arvestata ümber 

e. selle konto puhul jäetakse kontserni programmist käsitsi sisestatud number , ei võeta 

raamatupidamisest tegelikku summat. Sellist võimalust võib vaja minna näiteks kaubakulude 

korrigeerimise puhul e. selliste kontodega saab korrigeerida summasid , kui vajadus peaks 

tekkima . Korrigeerimissummad tuuakse aruannetes eraldi välja , näiteks nimetuse all 

‘Kaubakulude korrektsioon’ vm. 

Jääb kontserniaruannetest välja – linnuke lahtris tähistab , et seda kontot ei tooda 

aruannetesse . Aruannetest võib välja jätta näiteks vahekontod . 

 

Kontogrupid 

Kontogrupid võivad olla kontsernis erinevad tütarfirmade omadest . 

Kontogruppe saab koostada menüüst Registrid - > Kontogrupid  . 

Uue grupi lisamiseks tuleb teha ikoonil ‘Uus’ hiireklõps ning tühjad väljad täita järgmiselt: 

 Grupp  - kontogrupp, kuni 10 sümbolit, näites 1. 1.  

 Tüüp –  Aktiva, Passiva , Kulud , Tulud . Tehke noolekesel hiireklõps ning valige sobiv variant .  

 Nimetus – kontogrupi nimetus 

 Võõrkeeles – kontogrupi nimetus võõrkeeles 

 

Firmade andmikud 

Arvutus 

Menüüst ‘Arvutus ‘ käivitatakse tütarfirmade käibeandmike ümberarvutus . Arvutatakse 

ümber jooksev kuu ja aasta kõik tütarfirmad. Arvutus tähendab seda, et programm käib läbi kõik 

raamatupidamise kataloogid vastavalt firmade kirjeldusele ning võtab tütarfirmade käibeandmikest 

summad kontserni käibeandmikku . Kontsernis tekib iga kuu ja konto kohta üks käibe number , käibe 

arvutamine sõltub konto tüübist : 

Aktiva konto  == deebetkäive – kreeditkäive 

Passiva konto == kreeditkäive – deebetkäive 

Kulud              == deebetkäive 

Tulud               == kreeditkäive 

  

 Ümberarvutamise jaoks on olemas ka kiirnupuke , mis on nupukeste real tähistatud 

suure rohelise kalkulaatori pildiga.  
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Firmade andmike ümberarvutuse ajal jookseb ekraani alumisel ribal info selle kohta, millist firmat 

parajasti ümber arvestatakse. Ümberarvestamine on lõppenud, kui ribal on teade: 

Firmade ümberarvutus lõppenud  

   

Firmade käibed 

Menüüst ‘Firmade käibed ‘ - >   firma 1   käibed on võimalik vaadata ja kontrollida 

ümberarvestamise tulemust. Ekraanile tuuakse firmade kaupa käibeandmikud . Menüüs on täpselt sama 

palju ridu ,kui palju on firmasid kirjeldatud menüüs Registrid - > firmad . 

Käibeandmiku veergudeks on kuud ja ridadeks kontod tütarfirmade kaupa. Kui firmakood on 

0, siis on tegu kogu firma summaga (peab võrduma raamatupidamises kogu firma konto summaga ), 

kui firmakood on 2, siis on tegu teise tütarfirma summaga.  

Konto järgi otsimiseks tuleb alustada numbri sisestamist, mille tulemusena avaneb ekraan, 

kuhu saab trükkida konto numbri ning Ok nupukesel hiireklõps viib kursori otsitud konto reale.  

Kontrollida saab, kui minna jooksva firma raamatupidamisprogrammi ning avada seal teise 

tütarfirma käibeandmik ning konto numbri järgi kontrollida , kas summa on sama. 

Tavaliselt on ühe konto kohta mitu rida – firmakoodiga 0  ja siis erinevate firmakoodidega 

summad, mis tähistavadki erinevaid tütarfirmasid. 

Selles tabelis saab sisestada kuude kaupa summasid kontodele, mille kaardi peal on märge 

lahtris ‘Sisestatakse käsitsi (ei summeerita ) ‘ (v. t. ka registrid - > kontod ) . Summa sisestamiseks 

tuleb teha konto ja tütarfirma real topelthiireklõps või ‘Muud’ nupukesel hiireklõps, mille tulemusena 

avaneb sisestusekraan , kus on lahtrid kuude kaupa – sisestage summa õige kuu lahtrisse.  

Kui tütarfirmade käibeandmikud on ümberarvutatud ning summad kontrollitud, võib 

aruandeid koostada.  

 

Aruanded 

Taandatud bilanss 

Menüüst Aruanded - > Taandatud bilanss saab koostada kontserni bilansi. Programm küsib aruande 

käivitamisel  perioodi , sisestage kuude vahemik, näiteks 1 kuni 12 . Ekraanile tuuakse kontserni 

taandatud bilanss. Aruande veergudeks on tütarfirmad , ridadeks kontogrupid ning  kõige viimastel 

ridadel on välja toodud 

raamatupidamislik  aktiva , passiva  (peab võrduma raamatupidamisprogrammiga ) 

kontsernisisene aktiva, passiva  

taandatud aktiva , passiva. 

 

Raamatupidamislik summa kujuneb tütarfirma andmikust ridadelt, millede firmakood on null  

Kontsernisisene summa kujuneb nende kontode summast, millede ekraanil on märge, et  

‘Sisekäibed taandatakse’. 

Taandatud e. puhas summa kujuneb käibeandmiku 0 firma ja tütarfirmade summade vahena . 
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Toome siinkohal täpsustava kirjelduse summade kujunemisest. 

1.Puhas aktiva = algsaldo + käive (0 firma - tütarfirmad) käibeandmiku summade järgi. 

Lahutamine toimub, kui konto kaardil on 'sisekäibed taandatakse' ja  ei lahutata, kui seda 

märget pole. 

P.S. Kui on tehtud kanne, kus on selle märke poolest erinevad kontod, siis see ei aja paigast ära. Siis ei 

tule reale 'kontsernisisene' summat ja puhas = raamatupidamislik . 

2. Kontserni sisene - summeeritakse punktis  1 toodud summad ainult siis, kui 

tegu on tütarfirmaga  e. firma kood  # 0 ja vastavalt siis konto tüüp on Aktiva  või Passiva. 

Rea summa sõltubki märkest  'sisekäibed taandatakse' 

P.S. Puhas + kontsernisisene = raamatupidamislik  

3. Raamatupidamislik  - summeeritakse punktis  1 toodud summad ainult siis, kui firma 

kood  = 0 ja vastavalt siis konto tüüp on A või P    (summad võetakse raamatupidamise kontserni 

moodulist ja neid saab vaadata, kui tütarfirma = null )   

Puhasaktiva ja puhaspassiva ei võrdu, kui : 

1. Teha  kanne ja kreedit (või deebet ) kontole panna tunnus kontsernis, et jääb  

 aruannetest välja. 

2. Raamatupidamises  kontserni käibeandmikud (s.h. null firma) on tasakaalust väljas 

 

Lisaaruanded 

Menüüst Aruanded -> Lisaaruanded saab koostada aruandeid, milledes tuuakse välja 

summad kontode tasemel, et oleks võimalikult lihtne leida vigu ning võrrelda tütarfirmade 

käibeandmike andmeid. 

Näiteks aruandes ‘Kasumiaraunne kontodega ‘on toodud kõik tulude-kulude kontod ning 

summad, samuti aruandes ‘Bilanss kontodega ‘ , on toodud aktiva ja passiva kontod 

summadega.   

 

 

Tööperioodi muutmine 

Töökuu 

Menüüst File -> Töökuu on võimalik vahetada töökuud. Ekraani kõige 

alumisel ribal on näha, millises aastas ja kuus programm asub. Tööperioodi 

õige valik on oluline, kuna ümberarvutus tehakse konkreetselt ainult 

jooksvale kuule. Hiireklõps menüül avab kuude nimekirja, millest tuleb valida 

sobiv kuu e. teha kuu nimel hiireklõps. 
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Tööaasta 

Menüüst File -> Tööaasta  on võimalik vahetada tööaastat . Ekraani 

kõige alumisel ribal on näha, millises aastas ja kuus programm asub. 

Tööperioodi õige valik on oluline, kuna ümberarvutus tehakse konkreetselt 

ainult jooksvale kuule ja aastale . Hiireklõps menüül avab menüü : 

 eelmine aasta – programmi jooksvaks aastaks saab üks aasta vähem, kui  

olemasolev 

 järgmine aasta – programmi jooksvaks aastaks saab üks aasta rohkem , kui  

olemasolev  

 jooksva aasta lõpetamine – vahetab aasta ühevõrra suuremaks ning kopeerib  

kontoplaani ja kontogrupid järgmiseks aastaks   

Andmehooldus 

 Andmehoolduse menüüd tuleb kasutada alati, kui on olnud 

voolukatkestus või arvuti on seisma jäänud ja te olete pidanud poole 

programmi töö pealt tegema arvutile alglaadimise või teile tundub, et 

programm käitub imelikult. 

Igal juhul tuleb pärast pikemat andmete sisestamist võtta andmetest 

koopia disketile. Programmis on erinevad andmehooldus menüü punktid, mida 

saab kasutada erinevates situatsioonides , enamkasutatavad on : 

 andmebaasi koopia 

 uued indeksid 

 andmebaaside korrastus  

Kõiki andmehooldus menüüsid saab käivitada peamenüüst FILE ja sealt 

Andmete hooldus. 

Uued indeksfailid kustutab kõik CDX laiendiga failid ning genereerib nad 

uuesti. 

Andebaaside korrastus kustutab andmebaasidest tühjad / mittevajalikud 

kirjed.  

 

Koopia 

Koopia menüüpunkti kasutatakse juhul, kui tahetakse teha andmetest reservkoopiat. 

Reservkoopiat tuleb teha alati enne uue programmiversioonikopeerimist ja soovitavalt alati 

peale suurema töö tegemist, näiteks iga päeva/nädala/kuu lõpus.  

Reservkoopiat saab teha peamenüüst File ja sealt Andmete hooldus -> Andmebaasi koopia. 

Käsurida reservkoopia tegemiseks tuleb sisestada programmi parameetritesse lahtrisse ‘Käsk 

andmekoopia loomiseks’ , näiteks  

zip T:\bilcopy -rp *.* -x *.cdx *.exe *.tmp *.txt *.zip *.rp5 *.dll *.hlp  
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Uued indeksfailid 

 Uute indeksite menüüpunkti tuleb kasutada juhul, kui programmi töö ajal on olnud 

voolukatkestus või arvuti on programmi töö ajal mistahes põhjusel seisma jäänud. Samuti 

juhul, ,kui Te olete programmi töö ajal olnud sunnitud tegema arvutile alglaadimise. Uute 

indeksite menüü punkti peal hiire klõps kustutab kõik indeksfailid ning programm koostab 

need siis ise uuesti. Olenevalt andmete hulgast võib see tegevus võtta mõningase aja - mõned 

minutid. 

 Uusi indeksfaile saate koostada peamenüüst File ja sealt Andmete hooldus -> Uued 

indeksid. 

 

Printerid,kasutajad 

Printerid 

Kontserniprogramm kasutab aruannete jm. trükiste trükkimiseks WIN alla häälestatud 

printerit, mida on võimalik vaadata ja ka häälestada menüüst File -> Seadistused  ja sealt Printerid. 

Ekraanile tuuakse kasutusel oleva printeri kirjeldus.  

 

Kasutajad 

Kasutajate andmetabelisse kirjeldatakse kõik programmi kasutajad. igale kasutajale 

sisestatakse tema võtmesõna. Kasutajate andmetabel on mõeldud selleks, et keegi peale oma 

töötajate ei saaks programmi sisse ega andmetele ligi. See on andmete kaitseks.  

Kasutajaid saab lisada peamenüüpunktist File -> Seadistused -> Kasutajad.  

Uue kasutaja lisamiseks tuleb kasutajate andmetabelis olles teha lisamise nupukesel 

hiireklõps, mille tulemusel programm küsib kõigepealt uut kasutajanime ( peab olema kuus 

tähte pikk).Trükkige uus kasutajanimi ning tehke OK nupukesel hiire klõps , mille tulemusena 

on ekraanil küsimus uue kasutaja võtmesõna kohta. Trükkige uue kasutaja võtmesõna ja tehke 

OK nupukesel hiire klõps.  Ekraanile tuleb küsimus kasutajataseme kohta. Kuna programmis 

pole kasutajatele kättesaadavad menüüpunktid tasemetega piiratud, siis tuleb siin programmis 

kasutajatasemeks alati trükkida 99 ja teha OK nupukesel hiire klõps. 

Sellega on uus kasutaja sisestatud. Uus kasutaja saab nüüd oma kasutaja nime ja võtmesõnaga 

programmi sisse. 

 

Lõpetamine,info 

Lõpetamine 

Programmist tuleb alati lahkuda, kasutades seda menüü punkti. Kui teha hiireklõps menüül FILE -> 

Lõpeta, suletakse korrektselt andmebaasid ja programm küsib , kas soovite töö lõpetada ning kui teete 

vastuse variandil JAH hiire klõpsu, suletakse programm. Kui Te arvutiga rohkem tööd teha ei soovi, 

võite arvuti välja lülitada.  
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NB! KUI PROGRAMM ON LAHTI E. EKRAANIL ON TAAVI TÖÖMENÜÜ 

VÕI ANDMETABELID, SIIS ARVUTIT EI TOHI KINNI VAJUTADA !!!!! 

 

 

Info 

Info menüü punkt on informatiivse info jagamiseks programmi versiooni, autorite, kasutaja 

jm. kohta. Seda menüüd on vaja kasutada juhul, kui programmi hooldajad paluvad teil näiteks läbi 

telefoni ette lugeda, mis versiooni Te kasutate .Tehke menüül  ‘Info’  hiire klõps ning ekraanile tuleb 

tekst, mida võite lugeda info saamiseks.  

 

Taandatud kasumiaruanne 

 

Kontserniprogrammi kaks põhilist aruannet on kasumiaruanne ja bilanss . Menüüst 

Aruanded on võimalik neid ka koostada. Aruande käivitamisel avaneb valikuekraan, millel 

saate märkida, mitu koopiat te soovite või siis, et te soovite hoopis aruannet eksportida. Edasi 

küsib programm perioodi, mille kohta aruannet soovitakse, trükkige kuude vahemik, näiteks 1 

kuni 12.  Aruanne tuuakse ekraanile (juhul, kui te teisiti ei märkinud ). Suuremaks saab 

aruannet teha ekraani paremal üla servas asuvast ruudukesest ning lehekülgi saab vahetada 

ekraani ülaservas asuvatest noolekestest : 

Next page -> leht edasi 

Previous page - > leht tagasi 

Last page - > viimane leht 

First page - > esimene leht 

 

Aruande veergudeks on tütarfirmad ning ridadeks on kontogrupid. Aruande aluseks on 

kontserni tütarfirmade käibeandmikud. Samuti kontrollitakse aruande koostamisel konto 

kaartidele märgitud tunnuseid (v. t. registrid - > kontod ). 

 

 

 

Andmebaaside korrastus 

 Baaside korrastuse protseduur on programmis ettenähtud andmebaaside 

korrastamiseks. Protseduur likvideerib andmebaasidest kustutatud ja mittevajalikud kirjed. 

Baaside korrastust saab teha peamenüüst File  ja sealt Andmete hooldus -> baaside korrastus .  
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